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CHAPTER 1

Introduction
Welcome to RVONedit

RVONedit is a Windows®-based GUI (graphical user interface) application for configuring and displaying RVON (VoIP) 
devices connected to your Matrix system. RVONedit is to the VoIP products as AZedit is to ADAM, Cronus, and Zeus. The 
RVON devices included are:

• RVON-8
• RVON-I/O
• RVON-1
• RVON-C

To fully use the RVONedit application, you must have the following minimum version installed:

NOTE: RVONedit can download firmware to older versions, but requires these versions in order to automatically detect the 
devices and to view or modify the device configurations.

Getting Started with RVONedit
Once you have updated the firmware for each RVON device through AZedit, serially, or by using Telnet, you can start using 
RVONedit by itself. When RVONedit is setup, you will be able to download firmware upgrades from the RVONedit screen.

Step 1
Using the RVONedit installation wizard, install RVONedit on the PC connected to the Intercom System (ADAM, Cronus, or 
Zeus).

FIRMWARE VERSION

RVON-8 V 2.0.0 or later

RVON-1 V 2.0.0 or later

RVON-I/O V 2.0.0 or later

RVON-C V 2.0.0 or later
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Introduction
Step 2
Add Devices to the RVONedit application. This can be done manually or automatically. For information on how to add 
devices to RVONedit see, “How to Add Devices to RVONedit” on page 44.

Step 3
Using the Device Configuration section of the RVONedit screen configure your RVON device.

RVONedit Field Types

FIGURE 1. RVONedit Field Types
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CHAPTER 2

Screen Descriptions
RVONedit Main Application Screen
The Main Application screen in RVONedit is split into three (3) main areas:

1. Device Catalog - Displays the RVON devices currently configured in your Intercom System.
2. Device Configuration - Displays the Device Status and Configuration options of each device.
3. Channel Configuration - Displays the Channel Status and Configuration options of each device.
5



Screen Descriptions
Device Catalog
Use the Device Catalog to view the RVON devices you have connected to your Intercom System. There are two ways to view 

these devices:  All Devices or  by Device Type.

The Device Catalog uses expandable/collapsible  trees. By clicking the “+” icon, you can open a catalog, or click “-” to 
close the catalog.

NOTE: You can also double-click By Device Type or All Devices to open and close the catalog tree.

When displaying All Devices, RVONedit, by default, displays the RVON devices in order of how the devices were added to 
the application.

The Device Catalog section of the RVONedit screen can be configured 
one of 3 ways:

All Devices - If you select Show All Devices in Preferences 
(Edit>Preferences or Alt+Enter), every RVON device in the 
Matrix displays

Device Type- If you select Show By Device Type in Preferences 
(Edit>Preferences or Alt+Enter) the RVON devices are 
grouped by the type of device it is.

 - RVON-8

 - RVON-1

 - RVON-I/O

 - RVON-C

NOTE: If you select both options, you will see duplicates of each of the 
RVON devices in the Matrix.
6



Device Catalog
When displaying the RVON devices by Device Types, you will see color coded squares to distinguish between the different 
RVON products.

= RVON-8

= RVON-1

= RVON-I/O

= RVON-C

NOTE: Initially, when RVONedit is installed, the device catalog will be empty. Remember to update your RVON firmware 
to the minimum requirements (see page 3) before you Add Devices to RVONedit.

Once you have finished adding the RVON devices to the catalog, you can now display its configuration and status section of 
the RVONedit screen.
7



Screen Descriptions
Device Configuration and Status
The Device Configuration and Status section displays information about the selected device. Device Information is grouped 
into four(4) sections:

• Device Information and Status
• Pass-Through and/or GPI/O Support Information
• SNMP Information
• Authentication Information

Use the Device Configuration and 
Status section to configure or display 
configuration settings.

The GPI/O section (outlined in Red), 
only displays when RVON-1 is the 
selected device.
8



Device Information and Status
Device Information and Status

Use the Device Information section to configure and display your RVON device. Using the Expand/Collapse button , you 
can collapse or expand each section of the Device Configuration and Status section. When collapsed, only the section heading 
appears.

UNDER CONFIGURATION
Description A text description (up to 63 characters) of the device. This description can be displayed instead of 

the IP Address in the Device Catalog see “Use Device Descriptions in the Device Catalog” on 
page 55

IP Address The IP (Internet Protocol) Address for the RVON device.

Netmask The Netmask of the network to which the RVON device is connected.

Gateway The default Gateway address (if applicable) of the network to which the RVON device is 
connected.

Version Displays the current firmware version of the RVON device.

Disable Auto-
Negotiation

Disables Auto-negotiate and activates the Mode and Speed ratio buttons.
• Full Duplex - data moves both directions
• Half Duplex - data moves in one direction
• 100 Mbps
• 10 Mbps
9



Screen Descriptions
NOTE: All of the above fields, except Description, require ‘Admin’ privileges to modify. Changing the IP Address, Netmask, 
or Gateway will cause the device to reboot when the changes are sent.

Pass-Through and/or GPI/O Information

Use the Pass-Through and/or GPI/O Information section to configure the pass-through GPI/O settings for an RVON device 
(if applicable). 

Using the Expand/Collapse button , you can collapse or expand each section of the Device Configuration and Status 
section. When collapsed, only the section heading appears.

UNDER STATUS
Type Displays the type of RVON device being configured and what mode it is running in (if 

applicable).

Status Displays the current status of the RVON device and the current access rights of the user.

Sessions Displays the number of RVONedit sessions the device supports and how many are available (for 
example, 15/16 Available).

Channels Displays the VoIP connection states for each channel (green = connected, red = disconnected, 
gray = not configured).

Keypanels Displays the keypanel connection states for each channel (green = connected, red = disconnected, 
gray = not configured).

UNDER SERIAL 
TO ETHERNET

The Serial to Ethernet information shows the serial data that is received on the serial connection 
and transferred to the Ethernet address of the device to which the serial data is sent.

Tx IP Address Displays the IP Address of the device the serial data is sent.
10



Device Information and Status
Baud Rate Displays the baud rate of the serial connection.

Bytes Transferred Displays the number of bytes transferred from the serial connection to Ethernet.

Bytes Lost Displays the number of bytes that could not be transferred.

Errors Displays the number of errors that occurred during transfer.

UNDER 
ETHERNET TO 
SERIAL

The Ethernet to Serial information shows the serial data that is received on the Ethernet 
connection and transferred to the serial connection.

Rx IP Address Displays the IP Address from which data was last received via Ethernet (this address should 
match the Tx IP Address).

Unexpected Bytes Displays the number of unexpected bytes of data.
Unexpected Bytes are data that has come from any IP Address that is not the Tx IP Address. The 
bytes of data are considered invalid bytes and are not transmitted.

Bytes Transferred Displays the number of bytes that have been transferred to the serial port.
Bytes Lost Displays the number of bytes that could not be transferred.

Errors Displays the number of errors that occurred during the transfer.

UNDER SERIAL 
TO ETHERNET

The Serial to Ethernet information shows the serial data that is received on the serial connection 
and transferred to the Ethernet address of the device to which the serial data is sent.
11



Screen Descriptions
UNDER GPI/O

Mode: The mode in which the GPIO are to be used (Pass-Through forwards GPIO status to another 
device, otherwise the GPIO can be associated with All For One keypanel or One For Each 
keypanel).

1. From the drop down list, select the mode in which you want the device to operate.

When configuring the GPI/O mode on the RVON-I/O, there are three different mode options you 
may choose from:

Pass-Through Mode: In pass-through mode, GPI/O Status is sent over Ethernet, therefore 
you must set the IP Address of the destination GPI/O pass-through port.

1 Keypanel (single port) Mode: In 1 keypanel mode, also referred to as single port mode, all 
GPI/Os with a keypanel allows you to access/address the GPI/O in UPL Statements.

All Keypanel (multiple port) Mode: In all keypanel mode, also referred to as multiple port 
mode, each keypanel is associated to its corresponding GPI/O. For example, if keypanel 1 is 
connected to GPI/O 1, it is associated with the corresponding GPI/O port. When using All 
Keypanel Mode, an additional GPI/O is available. This means that each keypanel has four 
(4) GPI/Os and then a GPI/O associated with port nine (9).

NOTE: The extra port 9 is only available in ADAM intercom systems.

IP Address: The IP Address of the device with which GPI/O states are transferred (only valid when the GPIO 
mode is set to Pass-Through).

1. In the IP Address field, enter the IP Address of the destination GPI/O pass-through port.

Keypanel: The device port/keypanel number with which all GPIOs are associated (only valid when GPIO 
mode is set to All For One).

1. From the Keypanel drop down list, select the port that all GPIOs are associated.

Inputs: Displays a summary of the current GPI/O input states (purple = asserted, gray =input not asserted.

Outputs: Displays a summary of the current GPI/O output states (purple = asserted, gray = output not 
asserted.
12



Device Information and Status
SNMP Information
Use the SNMP Information section to configure the SNMP options for your RVON device (if you are using SNMP).

NOTE: This section is only shown if the device has SNMP support and the preference to Hide SNMP Configuration is not 
enabled (see “How to Show/Hide the SNMP Configuration Information” on page 56).

Using the Expand/Collapse button , you can collapse or expand each section in the Device Configuration section. When 
collapsed, only the section heading appears.

There are four (4) areas within the SNMP Sections:

• System Information
• Community Strings
• Valid Hosts
• Trap Targets
13



Screen Descriptions
System Information
The System Information area is purely for documentation purposes. This is so the user knows which device is configured and 
where it is physically located.

Community Strings

Valid Hosts

UNDER SYSTEM INFORMATION

Name: The name of the RVON device (up to 100 characters) in which SNMP is being configured.
1. In the Name field, enter the name of the device being configured.

Location: The location of the device (up to100 characters) with SNMP configured.
1. In the Location field, enter the physical location of the device (for example, Intercom Room, right 

rack).

Contact: The name (up to 100 characters) of the person responsible for the specified SNMP device.
1. In the Contact field, enter the name of the person responsible for the SNMP device.

UNDER COMMUNITY STRINGS

Read-Only: The password (up to 64-characters) providing read-only access.
1. In the Read-Only field, enter a password to allow read-only access.

Read-Write: The password (up to 64-characters) providing read-write access via SNMP.
1. In the Read-Write field, enter a password to allow read-write access.

Trapsa

a. An SNMP Trap is a notification event issued by a managed device (the Intercom System) to the network management 
station when an event or error occurs. When an event or error occurs, a message is sent to the SNMP Monitoring Soft-
ware with the Trap Community String description. By uniquely identifying these traps, you can quickly see which event 
or error takes precedence.

The community string (up to 64-characters) that is included in any TRAP PDU (protocol data unit) 
generated by the device.

UNDER VALID HOSTS:

Valid Hosts: A list of up to five (5) hosts from which the device will accept SNMP requests (only used if Use Hosts? 
is selected).
1. In the IP Address field, enter an IP Address for a valid host.
2. Click Add.

Use Valid 
Host?:

Enables or disables the valid hosts list.
14



Authentication Information
Trap Targets

Authentication Information

Use the Authentication Information section to configure up to five (5) profiles for the selected device. Each profile can be 
given different access rights or privileges: Admin, Read, Write, Telnet, Download.

NOTE: Access Rights, also called Privileges, are an identified set of rights an individual user or group of users has to a 
particular resource. The RVON devices support an authentication table that can contain up to five (5) entries (each 
with a user name, password, and access rights).

The Access rights for the RVON devices are as follows:

R Read (user can view status and configuration)
W Write (user can modify most configurable elements)
A Admin (user can modify advanced configuration elements)
T Telnet (user can connect to the device via Telnet)
D Download (user can download new firmware to the device)

Warning! It is possible to create an empty authentication table, disabling RVONedit, Telnet, and firmware downloads. If 
this occurs, you can restore the default authentication table by turning ON a DIP switch for the specific RVON 
device and restarting the device. Once the device has been restarted, then turn the DIP switch to the OFF position 
and restart the device again.

The following is a list of the DIP Switch number for each RVON device type:

RVON-8 DIP Switch 5
RVON-1 DIP Switch 2
RVON-I/O DIP Switch 3
RVON-C DIP Switch 5

UNDER TRAP TARGET

Trap Targets: A list of up to five targets the device will send SNMP traps to when they occur.
1. In the IP Address field, enter the IP Address of a target to which a trap will be sent.
15



Screen Descriptions
Using the Expand/Collapse button , you can collapse or expand each section in the Device Configuration section. When 
collapsed, only the section heading appears.

NOTE: This section is only shown if the current access rights include ‘admin’ and the preference option Hide Authentication 
Table is not enabled (see “How to Show/Hide the Authentication Table” on page 57).

When creating the profiles, the following must be observed:

User Name: Can be up to 40 characters long

Password: Can be up to 40 characters long

Access Rights: Select the access for the user you are creating.

Recommendations:

• For security purposes, it is recommended you change the authentication table default user names and passwords 
so they are not easily accessible by anyone on your network.

• We also recommend that you select “Remember for this device” when logging onto different devices. By 
enabling this feature, RVONedit remembers the user names and passwords to logon to each device, especially if 
you are planning to make different authentication tables for each device. By having RVONedit store the logon 
information, you will eliminate having to logon to each device.
16



Channel Configuration And Status
Channel Configuration And Status
Use the Channel Configuration and Status section to configure or view the channels for each RVON device. Channel 
Configuration and Status is divided into five sections:

• Channel Configuration
• Channel Status
• VOIP
• Network Status
• Error
17



Screen Descriptions
Channel Configuration
Use the Channel Configuration section of the grid to configure channel settings for each applicable device channel.The 
channel configuration displays the following fields: Channel Description, Destination Type, Destination IP Address, 
Destination Description, Destination Channel, Destination Channel Description, Coding Algorithm, Audio/Packet, VAD 
State, VAD Threshold, Channel Input Gain, Channel Output Gain, Keypanel Polling ID, and Keypanel Polling Baud Rate.

NOTE: If you are connected to a device with ‘Write’ or ‘Admin’ privileges, a context menu is available that allows you to 
Tear Down Channels (right-click in the left title column) or Tear Down Individual Channels (right-click the channel 
column header). For information on how to tear down channels, see “How to Tear Down a Channel” on page 69.

Channel Description Displays the channel description, if applicable. To change the description, use the 
description field in the Device Information Section on page 9. 

Destination Type Displays the type of RVON device the channel is connected to.
1. Use the drop down list to select the type of device that is connected to the channel.

NOTE: When the RVON device is initially added to RVONedit, these fields will 
automatically populate with the current channel status.

Destination IP Address Displays the IP Address for the device at the other end of the connection.
This is an editable field. You can enter another IP Address. However, by changing this IP 
Address, the destination type will change if it can be determined.

Destination Description Displays the destination channel’s description, if applicable. 
This field cannot be modified.
18



Channel Configuration And Status
Destination Channel Displays the channel at the destination device to which the RVON device is connected.

1. Using the drop down list, select the channel at the destination that the RVON device is 
connected.

NOTE: When <default> is selected, the channels match 1 to 1. For example, you may 
have all channels selected, and by choosing <default>, Ch 1 matches to Ch 1, Ch 2 matches 
to Ch2. This options is a time saver so you do not have to manually assign each channel.

Destination Channel 
Description

Displays the destination channel’s description, if available. 

This field cannot be modified.

Coding Algorithm Displays the coding algorithm used to transmit audio packets.

1. Using the drop down list, select the coding algorithm to use for the selected channel.

Audio/Packet Displays the audio packet sizes for the selected coding algorithm.

1. Using the drop down list, select the audio packet size.

Values for this field are as follows: 10ms, 20ms, 30ms, 40ms, 60ms.

VAD State Displays whether VAD is enabled or disabled. Select the checkbox to enable or clear the 
checkbox to disable VAD.
NOTE: VAD (voice activity detection) saves network bandwidth by stopping the flow of 
audio packets when silence is detected.

VAD Threshold Displays the VAD threshold (for G.711 codec). Setting the VAD threshold tells the channel 
at what level to start the flow of audio packets. Otherwise, the channel will remain silent.

1. Using the up and down arrows select the VAD Threshold for the channel. 
The VAD threshold range is -30dB to -60dB or Adaptive.

Channel Input Gain Displays the channel input gain for the channel.
1. Using the up and down arrows, select the channel input gain. 

Select values between -14dB to 14dB.
NOTE: This field is not editable for devices that get output gain from the intercom.

Channel Output Gain Displays the channel output gain for the channel.
1. Using the up and down arrows select the channel output gain. 

Select values between -14dB and 14dB.
NOTE: This field is not editable from devices that get output gains from the intercom.
19



Screen Descriptions
NOTE: A Coding Algorithm is an algorithm used to compress audio. There are five (5) codices supported by Telex: G.711ms 
law, G.711A law, G.729AB, G.723 (5.3k) and G.723 (6.3k). The type of coding algorithm you choose will dictate the 
quality of audio you hear and the network bandwidth used. The packet size determines how much audio data is 
carried across the network in each transmitted packet. The CODEC type and packet size chosen require different 
amounts of bandwidth from the network. As with the coding algorithm, the packet size you choose for the audio 
transfer will affect the audio you hear and the bandwidth you use over the network. The larger the audio packet you 
choose to use, the lower the bandwidth used. However, the larger packet size can result in higher delay and longer 
gaps if the packet is lost. On the other hand, smaller packet sizes result in larger bandwidth use, but lower delays and 
smaller gaps if the packet is lost. The Intercom System Engineer and the Network Administrator may want to work 
together in choosing the coding algorithm and packet size suitable for the size of the network, so degradation of 
network resources does not occur.

Channel Status
The Channel Status displays read-only status information on the channel’s connection and communication status.

NOTE: If you are connected to a device with ‘Write’ or ‘Admin’ privileges, a context menu is available that allows you to 
Clear Connection Statistics for all channels (right-click in the left title column) or Clear Connection Statistics for 
Individual Channels (right-click in the channel column).

Keypanel Polling ID Displays the keypanel polling ID for the channel.
1. From the drop down list, select the keypanel polling ID (choose from 1 to 10, or select 

the dash to assign no polling ID).
NOTE: This field is only used with the RVON-I/O in remote mode.

Keypanel Polling Baud 
Rate

Displays the keypanel polling baud rate for the channel.
1. From the drop down list, select the keypanel polling baud rate. 

The option for this field are 9600 or 76.8 kbps.
NOTE: This field is only used with the RVON-I/O in remote mode.
20



Channel Configuration And Status
Connection State Displays the state of the connection. There are two connection states: Connected or Idle.

Connection Duration Displays the duration of the current connection or the previous connection, if in an idle 
state. This is shown in hh/mm/ss.

Coding Algorithm 
(actual)

Displays the coding algorithm negotiated for use with the connection. When this is 
displayed in red, it is different from the configured algorithm.

Audio/Packet (actual) Displays the audio per packet size of the current connection. When this is displayed in red, 
it is different from the configured audio/packet value.

VAD State (actual) Displays the current VAD state. When this is displayed in red it is different from the 
configured VAD State.

Connection Attempts Displays the number of times a call has been made.
NOTE: The number of attempts should always be one greater than the number of drops.

Connection Drops Displays the number of times a connection has been dropped.

Connection Origination Displays the end of the connection that originated the call.

Connection Termination Displays the end of the connection that terminated the call.

Release Reason Displays why the connection was terminated, for example, congestion, network error, local 
release, or remote release.
21



Screen Descriptions
VOIP Status
The VOIP Status displays read-only statistics and counters related to VOIP.

NOTE: If you are connected to a device with ‘Write’ or ‘Admin’ privileges, a context menu is available that allows you to 
Clear VOIP Statistics for all channels (right-click in the left title column) or Clear VOIP Statistics for Individual 
Channels (right-click in the channel column)

Playout Buffer Size Displays how much audio can be received from the network before packets are lost. This is 
four (4) times bigger than the configured packet size. This is a static system setting.

Nominal Playout Delay Displays how much audio is collected before playout begins. Playout begins at half the 
Playout Buffer Size, which is two (2) times the configured packet size. This is a static 
system setting.

Average Playout Delay Displays the actual average audio collected before packets are played out. This is measured 
over the length of the connection.

Playout Buffer Underrun Displays the number of times that packets were not played because the Playout Buffer was 
empty.

Playout Buffer Overrun Displays the number of packets that were discarded because the Playout Buffer was full.
Missing Sequence 
Packets

Displays how many audio packets were missed in the sequence.

Replayed Packets Displays how many audio packets were replayed.

Average Frame Jitter Displays the measure of consistency of packet arrival time. Lower jitter is better.
22



Channel Configuration And Status
Network Status
The Network Status displays read-only network statistics and counters.

NOTE: If you are connected to a device with ‘Write’ or ‘Admin’ privileges, a context menu is available that allows you to 
Clear Network Statistics for all channels (right-click in the left title column) or Clear Network Statistics for 
Individual Channels (right-click in the channel column)

Voice Playout Packets 
(Tx/Rx)

Displays the number of voice packets transmitted and received from the other side of the 
connection.

DTMF Relay Packets 
(Tx/Rx)

Displays the number of DTMF (dual tone multiple frequency) relay packets transmitted and 
received. DTMF relay packets are a bandwidth and quality saving feature within RVON 
products.

Silence Detection 
Packets (Tx/Rx)

Displays the number of times a silence detection packet has been sent or received. VAD 
(voice activity detection) must be enabled.

Packet Interarrival Time 
(Min/Max)

Displays the minimum and maximum time elapsed between packets being sent.

Recent Bandwidth Use 
(Tx/Rx)

Displays the amount of bandwidth used, in Kbytes/sec, over the length of the call.

Average Bandwidth Use 
(Tx/Rx)

Displays the amount of bandwidth used, in Kbytes/sec, over the length of the call.

This is a calculation of the number of voice packets transmitted and received and the length 
of the connection.
23



Screen Descriptions
Errors Grid
The Errors Grid displays the read-only Error Counters.

NOTE: If you are connected to a device with ‘Write’ or ‘Admin’ privileges, a context menu is available that allows you to 
Clear Error Statistics for all channels (right-click in the left title column) or Clear Error Statistics for Individual 
Channels (right-click in the channel column

Change User Screen
Use the Change User screen to logon to RVONedit/RVON devices as a different user. RVONedit administrators have the 
ability to create up to five (5) different user profiles with unique access rights/privileges (see page 3). This gives 
administrators the power to limit access to change device configuration values to a few users.

User profiles are created in the Authentication area of the Device Configuration and Status section. For more information, see 
“How to Add/Remove a User Profile To/From the Authentication Table” on page 61.

NOTE: By default, RVONedit is shipped with two default user profiles: ‘admin’ and ‘telex’. They both have the same default 
password: ‘password’. We highly recommend you give each user profile a unique password to prevent a security risk 
to your RVON device configurations.

Invalid Headers Displays how many IP packets could not be parsed.

Invalid MAC Address Displays how many invalid MAC addresses tried to connect.

Invalid SSRC Displays the number of packets with an invalid SSRC

Invalid Payload Displays how many incorrectly formatted packets were received.

Invalid Destination Displays how many invalid destinations were received.

Lost Packets Displays how many packets were lost.
DSP to Micro Overrun Displays the number of packets that were lost because the Micro was too busy to receive.
24



Change User Screen
FIELD DESCRIPTION
User Name area: The User Name area contains the following:

• User Name entry field
• Remember for this device check box
• Use as default for all devices check box

User Name field User names can be up to 40-characters long.
1. In the User Name field, enter a valid user name.

Remember for 
this device check 
box

The Remember for this device check box allows you to set the default user name or password used 
anytime a user is logging onto the specified RVON device.

Select the Remember for this device check box to have RVONedit remember the user name or 
password for future logon attempts.
Clear the Remember for this device check box to disable this option.

Use as default for 
all devices check 
box

The Use as default for all devices check box allows you to set the default user name or password for 
all devices in RVONedit.

Select the Use as default for all devices check box to have RVONedit remember the user name or 
password for future logon attempts.
Clear the Use as default for all devices check box to disable this option.

Password area: The Password area contains the following:
• Password entry field
• Remember for this device check box
• Use as default for all devices check box
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Screen Descriptions
Preferences Dialog
The Preferences dialog allows you to set application, device and channel options for RVONedit.

The Preferences dialog has four pages: 

• Catalog page - Allows you to set display options for the device catalog, such as the way RVON devices are seen.
• Devices page - Allows you to set options for device preferences, such as auto-connecting and displaying device 

configuration areas.
• Channels page - Allows you to set options for channel configurations such as, column and row adjustments and 

display options for RVON-1 aux channel.
• Directories page - Allows you to set file locations for save and load directory defaults

You can also open preferences by selecting Edit>Preferences, by pressing Alt+Enter, or clicking the preferences icon .

Password field Passwords can be up to 40-characters long.
1. In the Password field, enter a valid password.

Remember for 
this device check 
box

The Remember for this device check box allows you to set the default user name or password used 
anytime a user is logging onto the specified RVON device.

Select the Remember for this device check box to have RVONedit remember the user name or 
password for future logon attempts.
Clear the Remember for this device check box to disable this option.

Use as default for 
all devices check 
box

The Use as default for all devices check box allows you to set the default user name or password for 
all devices in RVONedit.

Select the Use as default for all devices check box to have RVONedit remember the user name or 
password for future logon attempts.
Clear the Use as default for all devices check box to disable this option.

FIELD DESCRIPTION
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Preferences Dialog
Catalog Page

FIELD DESCRIPTION
Use description 
instead of IP address 
if available check box

This preference allows the user to see the RVONedit device description (if available), instead of 
the device IP Address. For example, if you have an RVONedit device with an IP Address, 
10.2.210.10, and a description, slot 2; in the Device Catalog (page 6) the description, slot 2, will 
be seen instead of the IP Address.

Show All Devices 
check box

This preference allows the user to see all RVONedit devices in the Device Catalog under All 
Devices.

Show By Device Type 
check box

This preference allows the user to see all RVONedit devices in the Device Catalog grouped by 
device type (for example, RVON-8, RVON-1, etc.).
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Screen Descriptions
Devices Page

NOTE: SNMP and Authentication information is only visible with logged in as ‘admin’.

FIELD DESCRIPTION
Auto-connect 
when changing 
devices check box

This preference allows you to auto-connect to RVONedit devices. This means that when you change 
devices within the device catalog, it will automatically connect you to that device or the user name 
and password screen will automatically pop-up for logon.

Hide SNMP 
configuration 
check box

This preference allows you to hide the SNMP configuration area. If you do not use the SNMP feature, 
you can hide the configuration options in the Device Configuration and Status section (page 8)
For more information, see “How to Show/Hide the SNMP Configuration Information” on page 56.

Hide 
Authentication 
Table check box

This preference allows you to hide the Authentication table. If you do not use the authentication 
feature, you can hide the configuration options located in the Device Configuration and Status 
section. For more information, see “How to Show/Hide the Authentication Table” on page 57.
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Preferences Dialog
Channels Page

FIELD DESCRIPTION
Allow row height 
adjustments check box

This preference allows you to make row height adjustments to the channel configuration grid 
(page 17).

Allow column width 
adjustments check box

This preference allows you to make column width adjustments to the channel configuration 
grid.

Hide RVON-1 aux 
channel check box

This preference allows you to hide the RVON-1 aux channela. Because this channel is not 
often used, by default, the channel is hidden.

a. An RVON-1 device supports two audio channels. One goes to the keypanel (mic and speaker), the other (the aux channel) allows 
you to connect to the aux input on the keypanel connected to the RVON-1.
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Screen Descriptions
Directories Page

FIELD DESCRIPTION
Device Catalog 
(.RVC) field

This preference allows you to set the file location where device catalog settings are stored. By 
default, it is set to C:\Telex\RVONedit\CATALOG.

Device Setup Files 
(.RVN) field

This preference allows you to set the file location where device setup files are stored. By default, it 
is set to C:\Telex\RVONedit\CATALOG\SETUPS.

Firmware Files 
field (.BIB)

This preference allows you to set the file location where firmware files are stored. By default, it is 
set to C:\Telex\RVONedit\CATALOG\FIRMWARE.
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Add Device
Add Device

Use the Add Devices screen to add RVON devices to RVONedit. There are two ways to add devices on the Add Device 
dialog:

• You can manually enter the device information. Use the Add Tab to perform a search for a specific RVON 
device by manually entering the IP Address.

• You can search through a list of IP Addresses. Use the Search Tab to look through a list of all configured RVON 
devices. When you highlight a device in the Available Devices list, the device information auto-populates the 
right portion of the screen.

For more information, see “How to Add Devices to RVONedit” on page 44.

FIELD DESCRIPTION
Add Tab

Specify Device 
section

Use the Specify Device section to enter specific information on the RVON device you are 
adding to the application, such as:

• IP Address
• Description
• Device Type
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Screen Descriptions
Send Changes 
The Send Changes dialog box displays the device and channel changes you make in RVONedit. Send Changes allows you to 
confirm the changes about to be implemented. You can clear any of the configuration check boxes if you want to cancel 
specific changes from being implemented.

IP Address field In the IP Address field, enter the IP Address of the RVON device you want to add to 
RVONedit. 
Once the IP Address is entered, the find button becomes active.

Find Button Click Find for RVONedit to search and find the IP Address you entered in the IP Address 
field.

Description 
field

The description field describes the RVON device you are adding to the application.
NOTE: If this description is different than what the RVON device has configured, the 
description is overwritten with the originally configured description.

Device Type 
drop down list

Use the Device Type drop down list to select the type of RVON device for which you are 
looking.

Device 
Information 
Area:

The Device Information area on the Add Device dialog displays information for the 
selected devices. Information includes:

• IP Address
• Description
• Type
• Sessions

Search 
Tab

Available 
Devices List

The Available Devices list displays every configured RVON device in the intercom 
system.
1. Highlight the RVON device you want to add to RVONedit, and then click Add.

NOTE: You can add multiple RVON devices by holding down the CTRL button and 
selecting each device individually or hold the CTRL+Shift and highlight the entire block 
of devices.

Device 
Information 
Area:

The Device Information area on the Add Device dialog displays information for the 
selected devices. Information includes:

• IP Address
• Description
• Type
• Sessions

FIELD DESCRIPTION
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Send Changes
NOTE: You can only view changes to one device at a time. Use the drop down list to change the device you are verifying 
changes.

This dialog only shows those items that have had changes made to them. If no changes have been made, then the grid item will 
not appear. For example, if you make changes to the IP Address on the RVON device, but make no changes to the description, 
the IP Address check box will appear, but the Description check box will not appear.

NOTE: To send changes to the intercom, you must have Write or Admin access rights for the data being sent.
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Screen Descriptions
FIELD DESCRIPTION
Showing all changes for: 
drop down list The Showing all changes for: drop down list displays all the different RVON devices on 

which changes have been made.
NOTE: you can only view the changes made on one RVON device at a time. 

DEVICE CONFIGURATION OPTION CHECK BOXES
Destination Type check 
box

Changes have been made to a Destination Type.
Select this check box to apply the changes made to the Destination Type.
Clear this check box to cancel the change.

Destination IP Address 
check box

Changes have been made to a Destination IP Address.
Select this check box to apply the changes made to the Destination IP Address.
Clear this check box to cancel the change.

Destination Channel 
check box

Changes have been made to the Destination Channel.
Select this check box to apply the changes made to the Destination Channel.
Clear this check box to cancel the change.

Coding Profile check box Changes have been made to the Coding Profile.
Select this check box to apply the changes made to the Coding Profile.
Clear this check box to cancel the change.

VAD Threshold check box Changes have been made to the VAD Threshold.
Select this check box to apply the changes made to the VAD Threshold.
Clear this check box to cancel the change.

Channel Input Gain check 
box

Changes have been made to the Channel Input Gain.
Select this check box to apply the changes made to the Channel Input Gain.
Clear this check box to cancel the change.

Channel Output Gain 
check box

Changes have been made to the Channel Output Gain.
Select this check box to apply the changes made to the Channel Output Gain.
Clear this check box to cancel the change.

Keypanel Polling ID 
check box

Changes have been made to the Keypanel Polling ID.
Select this check box to apply the changes made to the Keypanel Polling ID.
Clear this check box to cancel the changes.

Keypanel Polling Baud 
Rate check box

Changes have been made to the Keypanel Polling Baud Rate.
Select this check box to apply the changes made to the Keypanel Polling Baud Rate.
Clear this check box to cancel the changes.
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Send Changes
FIELD DESCRIPTION
Showing all changes 
for: drop down list The Showing all changes for: drop down list displays all the different RVON devices where 

changes have been made.
NOTE: you can only view the changes made on one RVON device at a time. 

DEVICE CONFIGURATION OPTION CHECK BOXES

IP Address Check Box Changes have been made to a Device IP Address
Select this check box to apply the changes made to the Device IP Address.
Clear this check box to cancel the change.

Description check box Changes have been made to a Device Description
Select this check box to apply the changes made to the Device Description.
Clear this check box to cancel the change.
35



Screen Descriptions
Ethernet Settings check 
box

Changes have been made to the Ethernet settings.
Select this check box to apply the changes made to the Ethernet settings.
Clear this check box to cancel the change.

Pass-Through IP 
Address check box

Changes have been made to the Pass-Through IP Address.
Select this check box to apply the changes made to the Pass-Through IP Address.
Clear this check box to cancel the change.

Pass-Through Baud 
Rate check box

Changes have been made to the Pass-Through Baud Rate.
Select this check box to apply the changes made to the Pass-Through Baud Rate.
Clear this check box to cancel the change.

GPIO Mode check box Changes have been made to the GPIO Mode.
Select this check box to apply the changes made to the GPIO Mode.
Clear this check box to cancel the change.

GPIO Mode IP Address 
check box

Changes have been made to the GPIO Mode IP Address.
Select this check box to apply the changes made to the GPIO Mode IP Address.
Clear this check box to cancel the changes.

SNMP Information 
check box

Changes have been made to the SNMP Information.
Select this check box to apply the changes made to the SNMP Information.
Clear this check box to cancel the changes.

FIELD DESCRIPTION
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Paste Special
Paste Special
Use the Paste Special Screen to select different channel and/or device configuration items that have been copied from one 
device to the current RVON device. 

The Paste Special dialog has two pages:

The Channel Configuration Page - On this page, select the options you want to copy to the device and then select the channels 
on the selected device you want to paste the selected configuration options.

Channel Description 
check box

Select the Channel Description check box if you want to paste the Channel 
Description information to the new channel configuration. Otherwise, clear the 
check box to do nothing.

Destination Type check 
box

Select the Destination Type check box if you want to paste the Destination Type 
information to the new channel configuration. Otherwise, clear the check box to 
do nothing.

Destination IP Address 
check box

Select the Destination IP Address check box if you want to paste the Destination IP 
Address information to the new channel configuration. Otherwise, clear the check 
box to do nothing.
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Screen Descriptions
Options button
Pressing the Options button displays a context menu that displays the following options:

• Select, Clear or Invert the selections for either the device configurations or channel configurations or both sets of 
options.

• Toggle the options between the Clipboard Copy selections and the Paste Special Default options.
• Save the current option set as the Paste Special Default settings. This allows you to configure the standard Paste 

Special selections and remembers the settings between settings.

Destination Channel 
check box

Select the Destination Channel check box if you want to paste the Destination 
Channel information to the new channel configuration. Otherwise, clear the check 
box to do nothing.

Coding Profile check box Select the Coding Profile check box if you want to paste the Coding Profile 
information to the new channel configuration. Otherwise, clear the check box to 
do nothing.

VAD Threshold check box Select the VAD Threshold check box if you want to paste the VAD Threshold 
information to the new channel configuration. Otherwise, clear the check box to 
do nothing.

Channel Input Gain check 
box

Select the Channel Input Gain check box if you want to paste the Channel Input 
Gain information to the new channel configuration. Otherwise, clear the check box 
to do nothing.

Channel Output Gain 
check box

Select the Channel Output Gain check box if you want to paste the Channel Output 
Gain information to the new channel configuration. Otherwise, clear the check box 
to do nothing.

Keypanel Polling ID 
check box

Select the Keypanel Polling ID check box if you want to paste the Keypanel 
Polling ID information to the new channel configuration. Otherwise, clear the 
check box to do nothing.

Keypanel Polling Baud 
Rate check box

Select the Keypanel Polling Baud check box if you want to paste the Keypanel 
Polling Baud information to the new channel configuration. Otherwise, clear the 
check box to do nothing.

1-8 Channel check boxes The 1-8 columns represent the channels available to paste the selected channel 
information into, if applicable.
Select each channel (1-8) that you want to past the select channel information.
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Paste Special
The Device Configuration Page - displays the different options you can select to paste to the new device configuration.

Using the options on these pages, you can pick and choose what you want to copy to the current device.

IP Address check 
box

Select the IP Address check box if you want to paste the IP Address information to 
the new device configuration. Otherwise, clear the check box to do nothing.

Netmask check box Select the Netmask check box if you want to paste the Netmask information to the 
new device configuration. Otherwise, clear the check box to do nothing.

Gateway check box Select the Gateway check box if you want to paste the Gateway information to the 
new device configuration. Otherwise, clear the check box to do nothing.

Description check 
box

Select the Description check box if you want to paste the Description information 
to the new device configuration. Otherwise, clear the check box to do nothing.

Ethernet Settings 
check box

Select the Ethernet Settings check box if you want to paste the Ethernet Settings 
information to the new device configuration. Otherwise, clear the check box to do 
nothing.
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Options button
Pressing the Options button displays a context menu that displays the following options:

• Select, Clear or Invert the selections for either the device configurations or channel configurations or both sets of 
options.

• Toggle the options between the Clipboard Copy selections and the Paste Special Default options.
• Save the current option set as the Paste Special Default settings. This allows you to configure the standard Paste 

Special selections and remembers the settings between settings.

Download Firmware Screen
Use the Download Firmware screen to easily upgrade the firmware for any of the RVON devices. Remember, your user 
profile must have download privileges before you can download firmware to RVON devices. 

NOTE: You can only download firmware for one type of RVON device at a time. You can download to multiple similar 
RVON devices.

To Open the Firmware Download screen, do the following:

1. From the RVON menu, select Download Firmware.
The Download firmware screen appears.

Pass-through IP 
Address check box

Select the Pass-through IP Address check box if you want to paste the Pass-
through IP Address information to the new device configuration. Otherwise, clear 
the check box to do nothing.

GPIO Mode check 
box

Select the GPIO Mode check box if you want to paste the GPIO Mode information 
to the new device configuration. Otherwise, clear the check box to do nothing.

GPIO Keypanel 
check box

Select the GPIO Keypanel check box if you want to paste the GPIO Keypanel 
information to the new device configuration. Otherwise, clear the check box to do 
nothing.



Download Firmware Screen
NOTE: RVONedit can download firmware to any RVON device supporting the older rvonfile.exe utility, even those that 
do not yet support communicating device configuration and status to RVONedit. RVONedit does NOT support 
download of the ADAM2 bootcode, or any of the flash file system utility programs.

2. You will need to browse, using the browse button, for the correct firmware to use. By default, RVONedit looks in the 
Firmware folder in the application directory (C:\TELEx\RVONedit\FIRMWARE).

NOTE: The default firmware directory can be changed, see “How to set a default folder in RVONedit” on page 72.

FIELD DESCRIPTION
Select Device 
Type drop 
down list

Use the Select Device Type drop down list to select the RVON device for firmware upgrade.
1. From the Select Device Type drop down list, select the RVON device that you want to upgrade the 

firmware. 
The choices are:

• RVON-8
• RVON-1
• RVON-I/O
• RVON-C

Change User 
button

Use the Change User button to open the Change User screen (page 24). Use the change user button if 
your current user profile does not have Download Privileges and you want to switch to a user profile that 
allows for downloading.

Devices to 
Download 
columns

The Devices to Download columns display the following information.

IP Address: Displays the IP address of the RVON device (for example, 10.2.210.21).
Description: Displays the textual description of the RVON device (for example, slot 1).
Firmware Version: Displays the version of firmware that currently resides on the RVON device.
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Screen Descriptions
Status: Displays the status of the download of the firmware to the RVON device. You will see a 
blue status bar with each of the following:

Sending
Finishing
Complete

If you click Stop before the download is complete or something did not allow the download to 
finish, you will see a Failed message in this column.

Select 
Firmware 
File field

The Select Firmware File: drop down list displays the firmware for download. If you have downloaded 
different versions of the firmware and downloaded them to other RVON devices, then you will be able 
to use the drop down list to see the different versions that have been downloaded to other devices.

Auto-close 
after 
successful 
download 
check box

Select the Auto-close after successful download check box if you want the Download Firmware 
window to automatically close when the firmware download is complete. Otherwise, clear the check 
box to keep the window open after the firmware download.

Begin Button Click Begin to start the firmware download.

FIELD DESCRIPTION
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CHAPTER 3

Application Tasks
In this chapter you will find many setup and maintenance tasks that you may only perform once or perform on a daily basis:
43



Application Tasks
How to Add Devices to RVONedit
Once you have installed the RVONedit application, you must then add the device to be monitored or displayed. This may be 
done automatically or by manually entering the IP (Internet Protocol) Address.

To add devices to RVONedit, do the following:

1. From the RVON menu, select Add.
The Add Devices screen appears

To Search for the RVON devices, do the following:

1. Verify you are on the Search page of the Add Devices dialog.
2. From the Available Devices list, select the IP Address of the device you want to add to RVONedit.

NOTE: You can add more than one device at a time by doing the following:

• To select a block of IP Addresses, select (highlight) the first IP Address, press and hold Ctrl+Shift, 
and then scroll and select the last IP Address in the block you want.
All of the IP Addresses are selected.

• To select multiple IP Addresses that are not in a block, press and hold the Ctrl key, then select the IP 
Addresses you want to add to RVONedit.
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How to Add Devices to RVONedit
Notice in the IP Address field under Device Information on the right-hand side of the application pane, you 
can see <multiple selections>.

3. Click Add.
The devices are added to the RVONedit Catalog view.

4. Click Done.
The Add Devices screen closes.

To Add the Device Manually, do the following:

1. Click the Add tab.
The Add dialog appears.

2. Under Specify device, add the IP Address of the device to which you want to connect.
Once you have entered the IP Address, the Find button becomes active.

NOTE: You can only add one device at a time when entering the IP Address manually.

3. Click Add.
The Add Device screen remains open and the RVON device is added to the Catalog view on the main 
screen.

4. Repeat steps 1-3 to add more devices manually.
5. Once finished, click Done.

The Add Devices dialog closes.
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Application Tasks
How to Download firmware upgrades in RVONedit
Occasionally, RVON products have firmware upgrades. Once you have upgraded the RVON products to the required versions 
(see page 3) through AZedit, Telnet, or Serially, you can download firmware straight from RVONedit directly to the device.

To download firmware to the RVON cards, do the following:

1. From the RVON menu, select Download Firmware.
The Download Firmware screen appears.

2. From the Device Type drop down list, select the type of device to be upgraded with firmware (for example, RVON-8, 
RVON-1, RVON-I/O, or RVON-C).

3. From the Select Devices to Download: list, select the devices to which you want to apply the firmware.

NOTE: You can add more than one device at a time by doing the following:

• To select a block of devices, select (highlight) the first device, press and hold Ctrl+Shift, and then scroll and 
select the last device in the list.
All of the devices are selected.

• To select multiple devices that are not in a block, press and hold the Ctrl key, then select the devices one-by-one 
to add to RVONedit.

4. In the Select Firmware File: field, enter the path to the firmware update, or use the browse button  to navigate to the 
file.

5. Select the Auto-close after successful download checkbox, if you want to close the Download Firmware screen 
immediately after a successful download.

6. Click Begin.
The Download begins.
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How to Download firmware upgrades in RVONedit
NOTE: This may take a few minutes. You can watch the download and upgrade of the RVON device download status bar.

Once the download is complete, it may take a few minutes for the RVON devices to reboot themselves. You can also watch as 
the device blocks dim, and then re-light with the reboot.

7. Repeat steps 1 through 6 to download firmware to other RVON devices, otherwise click Done.

Disconnected
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How to Change User
To change user in RVONedit, do the following:

1. From the RVON menu, select Change User.
The Change User screen appears.

2. In the User Name field, enter the User Name of the profile you want to log on to RVONedit.
3. Select the Remember for this device checkbox, if you want the device to remember this user name for this device.
4. Select the Use as default for all devices checkbox, if you want this to be the default user profile for all devices in the 

catalog.
5. In the Password field, enter the password for the profile you are logging onto RVONedit.
6. Select the Remember for this device checkbox, if you want to the device to remember the password for this user profile.
7. Select the Use as default for all devices checkbox, if you want this password to be the default for all devices in the 

catalog.



How to Send Changes
How to Send Changes
When changes or modifications are made to most configuration options in RVONedit, they are not applied to the device until 
the changes are sent to the device.

To send changes to the device, do the following:

1. From the Changes menu, select Send or click the Send Changes icon .
The Send Change screen appears.

2. On the Send Changes screen, review the changes you are about to send to the device.
3. Make any modifications to the Send Changes screens that are necessary.
4. Click Send when you are finished, otherwise click Cancel.
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Application Tasks
How to Copy and Paste Channel Settings
RVONedit supports copying and pasting individual channel configuration setting, making it easy to setup configuration files 
for different channels on the same device or for channels on different devices.

To copy and paste channel settings, do the following:

1. From the Device Catalog, select the device you want to copy the channel configuration settings. 
2. In the Channel Configurations section, select the channel column header of the channel you want to copy.

3. From the Edit menu, select Copy or click the copy icon .
The channel settings are copied.

NOTE: You can also copy the settings by pressing Ctrl+C on the keyboard.

4. In the same Channel Configuration Grid, select a different channel column header on the same device or select a 
different device’s channel column.

5. From the Edit menu, select Paste or click the paste icon .
The copied information appears in yellow highlight.

NOTE: You can also paste the settings by pressing Ctrl+V on the keyboard.

6. Send or Save your changes.
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Use Paste Special to Paste Device Settings.
Use Paste Special to Paste Device Settings.
Paste Special allows you to copy entire device configuration settings of a device and then select specific configuration settings 
to paste to a new device.

To paste device settings using paste special, do the following:

1. From the Device Catalog, select the device to which you want to copy the device settings.

2. From the Edit menu, select Copy or click the copy icon .
The Device Settings are copied.

NOTE: You can also copy the settings by pressing Ctrl+C on the keyboard.

3. From the Device Catalog, select the device to which you want to copy the device settings.
4. From the Edit menu, select Paste Special.

The Paste Special dialog appears.

5. Clear the checkboxes of the device configurations you do NOT want to paste to the new device.
6. Once you are finished, click Paste.

The settings are pasted to the current device.
7. Send or Save the changes.
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Use Paste Special to Paste Channel Settings
Paste Special allows you to copy channel configuration settings of a device and then select specific channel settings to paste to 
a new device.

To paste channel settings using paste special, do the following:

1. From the Device Catalog, select the device to which you want to copy channel settings.

2. From the Edit menu, select Copy or click the copy icon .
The channel settings are copied.

NOTE: You can also copy the settings by pressing Ctrl+C on the keyboard.

3. From the Device Catalog, select the device to which you want to copy channel settings.
4. From the edit menu, select Paste Special.

The Paste Special dialog opens.

5. Clear the checkboxes of the channel settings and the channels you do NOT want to paste.
6. Once you are finished, click Paste.

The current settings are pasted to the current device.



How to Open Preferences
How to Open Preferences
You can configure the RVONedit application by setting some of the application configurations to fit your individual business 
needs.

To Open the Preferences dialog, do the following:

1. From the Edit menu, select Preferences or click the preferences icon .

There are four pages in the Preference Dialog notebook. These pages contain the following:

• Device Catalog Configurations - You can set how you see the devices in the catalog (By Type or All Devices). 
You can also enable using the Device Description instead of the IP Address in the Device Catalog.

• Row and column adjustments 
• Show/Hide Informational Areas - You can show or hide SNMP and/or the Authentication area of the Device 

Configuration section of the application.
• Default Information Folders - You can set the default folders to where RVONedit will save information for 

Device Catalogs, Setup Files, and Firmware Files.
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How to Show/Hide the Device Catalog
Once you have added devices to the device catalog, you are ready to configure them. If you do not have a need to refer to a 
device in the device catalog, you can hide the whole section, creating more room in the application window.

There are several ways to Hide/Show the Device Catalog.

• Double-click the divider bar.

• From the View menu, select Device Catalog.
When a check mark is beside Device Catalog, the catalog is showing. If there is no check mark present, the catalog is 
hidden.

• Press Ctrl+T on the keyboard. to hide the Device Catalog.
Press Ctrl+T on the keyboard again to open the Device Catalog.

Divider Bars
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Use Device Descriptions in the Device Catalog
Use Device Descriptions in the Device Catalog
Sometimes it is easier to recognize a unique name for a device, rather than its IP Address. You can configure RVONedit to 
show device descriptions (where available) in the device catalog.

To enable device descriptions in the device catalog, do the following:

1. From the Edit menu, select Preferences. or click the preferences icon .
The Preferences dialog appears.

2. Click the Catalogs tab.
The Catalog page appears.

3. Select the Use description instead of IP address if available checkbox.
4. Click OK.
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How to Show/Hide the SNMP Configuration Information
If you are currently not using SNMP in your Intercom System, you may choose to hide the SNMP configuration area in the 
Device Configuration and Status section of the application.

To hide SNMP Configuration information, do the following:

1. From the Edit menu, select Preferences or click the preferences icon .
The Preferences dialog appears.

2. Click the Devices tab.
The Devices page appears.

3. Select the Hide SNMP Configuration checkbox.
4. Click OK.
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How to Show/Hide the Authentication Table
How to Show/Hide the Authentication Table
If you are currently not using Authentication in your Intercom Systems, you may choose to hide the Authentication table in the 
Device Configuration and Status section of the application.

To hide the authentication table, do the following:

1. From the Edit menu, select Preferences or click the preferences icon .
The Preferences dialog appears.

2. Click the Devices tab.
The Devices page appears.

3. Select the Hide Authentication Table checkbox.
4. Click OK.
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How to Enable/Disable “Auto-connect the application when changing devices”

The Auto-connect the application when changing devices is a useful setting when you are viewing multiple devices in a 
session. When enabled, devices automatically connect to RVONedit when selected. This way, you do not have to manually 
connect the device.

1. From the Edit menu, select Preferences or click the preferences icon .
The Preferences dialog appears.

2. Click the Devices tab.
The Devices page appears.

3. Select the Auto-connect the application when changing devices checkbox to enable. Or, clear the checkbox to disable 
the option.

4. When finished, click OK. Otherwise, click Cancel.
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How to Save a Configuration File
Once you have made changes to a device’s configuration (both device and channel), you will want to save the configuration 
file for later use or to compare with later configuration files.

NOTE: Setup files are stored in XML (extensible markup language) format, which makes them viewable and modifiable in a 
standard text editor (Notepad, MS® Word, etc.) and are viewable in a web browser. The Authentication Table, if saved, is 
stored in an encrypted format, so a text editor cannot edit it.

To save configuration files, do the following:

1. From the File menu, select Save or click the save icon .
By default RVONedit stores all files in the Setups folder under the RVONedit directory. You may change this location by 
setting the default location. For more information, see “How to set a default folder in RVONedit” on page 72.

2. Click Save.

Regardless of where the setup files are stored, RVONedit always stores setup files for each device in a separate sub-directory 
named using the device’s IP Address. This keeps the setup files for each device separate from other devices.

NOTE: When saving a setup file, RVONedit does not include the configuration items the device is not capable of supporting 
(for example, SNMP, Pass-Through, or GPIO information). Also, it will not save the SNMP or Authentication Table unless 
the current user has admin rights and the preferences to hide these areas is not enabled.
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How to Load a File
Load File can be used to preview (and modify) items in a file. Loading a setup file is similar to opening a setup file. For the 
differences between File|Open and File|Load, see page 73.

To load a setup file, do the following:

1. From the File menu, select Load... or click the load icon .
The Load dialog appears.

2. Navigate to the file you want to load.
3. Click Open.

The file loads on top of the current configuration.

NOTE: When a file is loaded, the file overlays current device configurations. You can modify the loaded file to suit your 
needs. Once done making changes (if applicable) to the loaded file, you need to send changes to the device.

4. From the Changes menu, select Send (F10) or click the send changes icon .
OR
Save the configuration file.
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How to Add/Remove a User Profile To/From the Authentication Table
NOTE: To setup user profiles, you must have ‘Admin’ rights. For more information, see “Authentication Information” on 

page 15. Also, you cannot have Hide Authentication Table enabled.

To add user profile to the authentication table, do the following:

1. In the Device Configuration section, scroll to the Authentication Information area.
2. Click Add.

The User Name field becomes active and the table line is highlighted in yellow.
3. In the User Name field, enter a user name for the new profile (up to 40 characters long).

4. Double-click the Password field to make it active.
5. Enter a password (up to 40 characters).
6. Select the Access Rights checkboxes you want for this profile.
7. Send or Save your changes.

To Remove a user profile from the authentication table, do the following:

1. Click the user profile you want to remove from the authentication table. 
The profile is highlighted blue.

2. Click the Remove button.
The user profile is removed from the authentication table.

3. Send or Save your changes. 
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How to Expand/Collapse the Device Configuration Information Areas
Similar to the Channel Grid, you can hide the four (4) areas (individually) of the Device Configuration section of the 
application.

To Collapse a section that has been expanded, do the following:

1. In the Device Configuration section, click the collapse icon  in the upper right corner of the section you want to close.
The section closes.

To Expand a section that has been collapsed, do the following:

1. In the Device Configuration section, click the expand icon  in the upper right corner of the section you want to open.
The section opens.

How to Show/Hide Channel Columns
To Show/Hide Channel Grid columns, do the following:

1. Right-click the channel column header.
A context menu appears.

2. Select Hide Channel X (X being the channel column you want to hide).
3. Repeat steps 1 and 2 until you are finished hiding columns.
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How to Show/Hide Channel Columns
To show hidden columns, do the following:

1. Right-click the channel column header to open.
A context menu appears.

2. Select Show Channel.
A context menu appears.

3. Select the specific channel you want to open or select All Channels to open all hidden channels.
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How to Undo, Redo, and Abort Changes

UNDO
Use Undo to cancel one or more previous changes. There are no limits on the amount of times you can undo changes.

NOTE: Every time an abort changes, send changes, or File|Open/Load/Send is performed the undo history is cleared to 0 
previous actions.

To Undo changes, do the following:

1. From the Change menu, select Undo (Ctrl+Z). Or click the Undo icon .
The current action performed in RVONedit is undone.

REDO

Use Redo to revert one or more previous undo actions that you have done. There are no limits on the amount of times you can 
redo changes.

NOTE: Every time an abort changes, send changes, or File|Open/Load/Send is performed, the redo history is cleared to 0 
previous actions.

To Redo actions, do the following:

1. From the Change menu, select Redo (Ctrl+Shift+Z). Or, click the Redo icon .

ABORT

To abort the changes, do the following:

1. From the Change menu, select Abort or click the abort icon .
A message asking “Are you sure you want to abort all pending changes?” appears.

2. Click Yes to accept. Otherwise, click No to do nothing.

By clicking Yes, the changes are deleted and the warning message closes. By selecting No, the changes are untouched (and still 
active to be sent to the device) and the warning message closes.
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How to change the IP Address, Netmask, and Gateway
To change the IP Address, Netmask, and/or Gateway address for a device, do the following:

1. In the Device Configuration and Status section, modify the IP Address, Netmask, and/or the Gateway fields.
2. Once finished, Send or Save the changes to the device.

How to Setup the Pass-through Port
NOTE: To make changes to the Pass-through port you must have Write access to make changes to this area.

To setup the Pass-through device, do the following:

1. In the Device Catalog, select a device.
The Device Configuration displays the current configurations for the device.

2. In the Tx IP Address field, enter the IP Address to which the device will transmit audio.
3. From the Baud Rate drop down list, select the baud rate at which audio will be transmitted. 
4. Once finished, Send or Save the channels to the device.

How to Setup the GPIO for an RVON-I/O
NOTE: The GPIO section will only display if the device has Pass-Through or GPIO capabilities. To make changes to the 

GPI/O you must have Write access to make changes to this area.

To setup the GPIO for an RVON-I/O, do the following:

1. In the Device Catalog, select an RVON-I/O.
The Device Configuration displays the current configurations for the RVON-I/O device.

2. From the Mode drop down list, select the GPIO mode the device will run.
3. In the IP Address field, enter the GPIO IP Address (if applicable).
4. From the Keypanel drop down list, select the keypanel or port in which all GPIOs are associated.
5. Once finished, Send or Save the changes to the channels.

How to Manually Disconnect from RVONedit
To manually disconnect from RVONedit, do the following:

1. From the RVON menu, select Disconnect.
The RVON device is disconnected. The green check mark turns to a red X.

OR

1. From the toolbar, select the disconnect icon .
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How to Open a File
When a file is opened in RVONedit, the application will disconnect from the current device (if connected) and read the setup 
file. If the file being opened is for a device other than the current device, RVONedit will create the device in the catalog and 
switch to it.

To open a file, do the following:

1. From the File menu, select Open or click the open icon .
The Setup file dialog appears.

NOTE: If a catalog device is currently selected, RVONedit will default to showing you the files in the sub-directory named 
for the current devices’s IP Address. You can also use the File Open dialog to navigate to a different location to select 
a different directory to open.

2. Select the file you want to open in RVONedit and then click Open.
If the field is for a device other than the current device, RVONedit switches to the new device in the catalog. If the file is for 
a device that is not in the catalog, RVONedit will create a device in the catalog for the device.

3. Make any modifications or changes.
4. Save the setup file. You can also attempt to connect to the device and Load the file using Send Changes command.

NOTE: RVONedit will not read the SNMP Configuration or Authentication Table from the file unless you have ‘Admin’ 
rights, AND the preference to hide these sections is not enabled.
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How to Use the Forward and Back button
RVONedit remembers the devices that you view as you use the application (this function can be compared to a web browser’s 

history). Using the Go Back button  or the Go Forward button , you can back-track to devices you have already 
viewed.

How to Change Devices using the Device Catalog Tree
As with most of the actions in RVONedit, there are many ways to accomplish the same action. Changing devices is no 
exception. Not only can you use the F3 action, you can simply point and click, as well.

To use the Device Catalog Tree to change devices, do the following:

1. In the device catalog, click the device you want to configure or view.
The device configuration and channel configuration for the selected device appear.

2. To move to the device, click the device in the catalog.

NOTE: If you do not have the “Auto-connect the application when changing devices” option enabled, you may have to log on 
to each device when you switch devices. For more information on how to enable this feature, see “How to Enable/
Disable “Auto-connect the application when changing devices”” on page 58.

How to Change Devices using F3
RVONedit supports a toggle feature that allows you to toggle between the destination IP Addresses of two connected RVON 
devices using the F3 function key.

To toggle between two devices that share a connection, do the following:

1. While the keyboard focus is on any field containing a destination IP Address, press F3 on the keyboard.
The destination IP Address device becomes active allowing you to make configuration changes, if needed.

The fields where this action will work are Destination IP Address in the Channel Configuration Grid and the Tx IP Address in 
the Pass-Through and/or GPIO section.

NOTE: The destination device must be configured in RVONedit for this feature to work.
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How to Hide Individual Rows in the Channel Configuration Grid
RVONedit supports hiding individual rows within the Channel Configuration Grid. You can easily hide rows of information 
you do not want to view; leaving only the data you are interested in viewing.

To hide individual rows in the Channel Configuration Grid, do the following:

1. Right-click the row you want to hide.
A Hide <specified row> row menu item appears.

2. Select the Hide <specified row> row menu item.
The row is hidden.

3. Repeat steps 1 and 2 until you have hidden all the rows you want.

To show all the rows you have hidden, do the following:

1. Right-click the area where the rows are hidden and then select Show Attribute.
The hidden rows menu appears.
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How to Tear Down a Channel
2. You can either select individual rows to show or select All Attributes to restore all of the rows.

How to Tear Down a Channel
The Tear Down a Channel feature is used to reset a channel without rebooting the entire device. When a tear down is 
performed the device disconnects the audio channel and then reconnects the channel.

To tear down a channel, do the following:

1. In the Channel Configuration Grid, right-click a channel column header.
A context menu appears.

2. From the context menu, select Tear Down Channel X (X being the channel. For example, Channel 1, Channel 2, etc.).
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How to Set the Column Size in the Channel Configuration Grid
To Set the Column Size, you must have the Allow column width adjustments checkbox selected. You can find this option on 
the Channels page of the Preferences Dialog (Edit>Preferences).

To set the column size, do the following:

1. Right-click the column header where you want to size and then click Column Size.
The column size options menu appears.
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How to Set the Column Size in the Channel Configuration Grid
71

2. Choose one of the four column sizing options:

Auto-size this column - The column is resized to fit the text in the column.

Auto-size all columns - All columns are resized to fit the text in each column.

Auto-fit all columns to fit window size - The columns are adjusted to fit all columns within the Channel 
Configuration window.

Set all columns to this size - After manually resizing a column, you can select this option to make all 
the columns the same size based upon the selected column.

NOTE: As always, you can manually adjust individual columns. Click and drag the outside edge of the column you want to 
resize.
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How to set a default folder in RVONedit
Using the Directories tab in Preferences (Edit>Preferences), you can change the folder used to store different RVONedit files, 
such as Setups, Authentication, and Firmware files.

To change the default folder for RVONedit, do the following:

1. From the Edit menu, select Preferences.
The Preferences dialog appears.

NOTE: You can also click the preferences icon .

2. Select Directories.

3. In one of the file fields (Device Catalog, Device Setup Files or Firmware Files), enter the file path where you want to save 

each type of file. You can also use the browse button  to navigate to the folder.
4. Once you are finished, click OK.
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What is the difference between File|Open and File|Load?
While primarily the same, there are distinct differences between File|Open and File|Load.

File|Open
• If the application is connected to a device when File|Open is performed, it automatically disconnects when the 

file is opened.
• If a catalog device is currently selected when the File|Open is performed, RVONedit will disconnect (if 

connected) from the current device and read the file.
• If the file that is opened is for a different device, RVONedit will switch to the new device in the catalog. If the 

new device is not in the catalog, it will create the device with the file parameters.

After a file has been opened, you can view/modify the configuration settings. You can save the changes to the existing file or 
create a new setup file by performing a File|Save. You can also connect to the device and Send the changes to the device.

File|Load
• The application is not disconnected from the current device (if connected).
• The setup file may contain information for a device other than the device you are currently viewing. RVONedit 

will not switch to the new device.
• The items in the setup file are overlaid on the current device and marked as changed when they are read.

After a file has been loaded, you can modify the file before you sent it to the device using the Send Changes command.

NOTE: Partial loads and partial saves are not supported in RVONedit. This means that all information in a setup file that can 
be loaded will be loaded.
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How to manually connect an RVONedit device
To manually connect an RVONedit device, do the following:

1. Highlight the RVON device with which you want to connect.
Notice the RVON device has a red X signifying that it is not connected.

2. From the RVON menu, select Connect.
The red X changes to a green �. If the device does not have any logons associated with it, it will automatically connect. 
Otherwise, a logon screen appears, prompting for you for a user name and password.
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How to Update Older Version RVON Devices Using RVONedit
In RVONedit you can add an RVON device that does not have the required firmware installed, but not be connected to it (the 
device icon is dimmed). But, if the device is running a lower version firmware (as noted below), you can update to the required 
firmware version.

RVON-8 = version 1.2.0 or higher
RVON-1 = version 1.1.0 or higher
RVON-C and RVON-I/O = version 1.0 or higher

To update older version RVON devices, do the following:

1. From the RVON menu, select Add.
The Add devices dialog appears.

2. Click the Add tab.
3. In the IP Address, enter the IP Address of the RVON device without the required firmware.
4. From the Device Type drop down list, select the type of device it is (for example, RVON-8).
5. Click Add.

The RVON device is added to the catalog, but the RVON device is dimmed, which means that RVONedit cannot talk with the 
device.

6. Select/highlight the RVON device you just added.
7. From the RVON menu, select Download Firmware.

The Download Firmware screen appears.
8. From the Device Type drop down list, select the type of device you want to download the firmware (for example, RVON-

8).

9. From the Select Device to Download list, select the device to which you want to upload the firmware.

NOTE: You can update more than one device at a time by doing the following:

• To select a block of devices, select (highlight) the top device, press and hold Ctrl+Shift, and then scroll and select the last 
device in the block you want.
All of the devices are selected.
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• To select multiple devices that are not in a block, press and hold the Ctrl key, then select the devices one-by-one you want 
to add to RVONedit.

10. In the Select Firmware File: field, enter the path to the firmware update, or use the browse button .
11. Select the Auto-close after successful download check box, if you want to close the Download Firmware screen 

immediately after a successful download.
12. Click Begin.

The download begins.

NOTE: This may take a few minutes. You can watch the download and upgrade of the RVON device download status bar.
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